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In dieser Anleitung zeigen wir dir, wie du ein StratoIno Board selbst aufbaust und wie du es mit dem 

Arduino Entwicklungssystem verbindest. Du benötigst  zusätzlich zu den Bauteilen oben, einen nicht 

zu großen Lötkolben, Lötzinn, etwas Erfahrung im Löten und ein wenig Zeit. Legen wir los! Hier sind 

die Komponenten des StratoIno: 

        

    AM2302 Sensor  Adafruit BME280 Sensor     Adafruit Ultimate GPS FeatherWing  

 

   

   Adafruit Feather M0 Adalogger Montagematerial  Motherboard  



  

    

Platine bestückt         + Feather M0 Adalogger   + Adafruit BME280 

 

                     

      + GPS FeatherWing         + AM2302            + Kabel zum Computer 

Die Adafruit Komponenten sind bei Adafruit erhältlich, oder, wie auch der AM2302 bei den bekannten 

Arduino/Adafruit Händlern. Die Platine muss mit Hilfe der bei SatTec verfügbaren Schaltskizzen selbst 

geätzt werden. Alternativ kann man auch eine Lochrasterplatine verwenden. An die Adafruit Module 

werden Stiftleisten (im Lieferumfang gelötet). Anleitung dazu gibt es auf der Adafruit Seite. 

Das Montagematerial, also passende Buchsenleisten zu den Adafruit Modulen, eine 3-polige 

Lüsterklemme zum Löten, 6 M3 Plastik Gewindebolzen mit 1cm Länge, sowie 6 kurze M3 Schrauben, 

möglichst aus Kunststoff, gibt es bei den üblichen Großhändlern (Bürklin, Reichelt,Conrad uvm).  

Die bedruckte Seite der Platine ist oben, alle Lötstellen sind unten. Um die Stiftleisten der Adafruit 

Module exakt parallel anzubringen empfiehlt es sich, sie mit dem längeren Ende in die Platine zu 

stecken (nicht verlöten!) oben das Adafruit Modul aufzustecken und jeweils einen Pin pro Reihe 

anzulöten. Dann kann man kontrollieren, ob es passt und gegebenenfalls korrigieren. Erst dann sollte 

gelötet werden.  

Die Bohrungen auf dem BME280 Board sind nur 2,5mm im Durchmesser. Sie müssen auf 3,0 – 3,2 mm 

aufgebohrt werden. Falls keine Plastikschrauben verwendet werden, bitte unbedingt überprüfen, dass 

der Schraubenkopf am BME280 Modul keinen Kurzschluss verursacht! 

Der AM2302 Sensor wird an die Lüsterklemmen angeschraubt. Es ist günstig, die Drahtenden vorher zu 

verzinnen, dann ist der Kontakt besser. Die Klemmen sind beschriftet, rot = plus, schwarz = minus, gelb  

= Daten. 

Bitte noch einmal alle Lötstellen auf saubere Lötstellen und Kurzschlüsse mit den Nachbarpins 

kontrollieren.  

Als nächstes installieren wir die Arduino Software. 



Arduino installieren 

 

 

 

 

 

 

 

 

 

 

Nun zur Software. Als erstes wird die Arduino Software installiert (https://www.arduino.cc/). Günstig ist es, die 

Software im Root Verzeichnis zu installieren bei mir also z.B. unter C:\ arduino-1.8.0.  

Wenn alles installiert ist, Arduino starten. Es sollte jetzt ähnlich wie oben aussehen, nur dass noch keine 

Datenlogger Software geladen ist. 

Damit alles funktioniert sind jetzt noch verschiedene Schritte notwendig: 

1.) Die Arduino Software richtig einstellen. 

2.) Die Files für den verwendeten Prozessor herunterladen installieren 

3.) Die Library Files für die verschiedenen Boards herunterladen und installieren 

4.) Das Arduino Programm herunterladen und installieren 

5.) Das Board an den Computer anschließen 

6.) Überprüfen, ob die serielle Schnittstelle funktioniert 

7.) Überprüfen, ob sich das Board über die serielle Schnittstelle meldet 

8.) Das Programm kompilieren und auf das Board übertragen 

9.) Anhand der LED’s und des Seriellen Monitors überprüfen, ob das Board auch läuft. 

Klingt nach viel und nach kompliziert, ist aber nicht allzu schwierig, fangen wir also damit an. 

Bitte beachte: Wir übernehmen keinerlei Verantwortung für die hier angegebenen Links oder für mittelbare 

oder unmittelbare Schäden, die aus Anwendung oder Modifikation der Software und Libraries entstehen! 



 

 

 

 

 

 

 

 

 

Zunächst das Menu Files-> Preferences öffnen. Das Fenster sieht wie oben aus. Die Sketchbook 

Location ist in meinem Fall: C:\Users\Admin\Documents\Arduino , also unter „Eigene Dokumente“. 

Es ist empfehlenswert den Ordner unter Dokumente oder im Stammverzeichnis C: anzulegen, um 

den Überblick zu bewahren. In diesen Ordner kommen übrigens auch die eigenen Libraries (nicht die 

Arduinio internen). Aber dazu später mehr. 

Unter additional Boards Manager URL tragen sie bitte ein: 

https://adafruit.github.io/arduino-board-index/package_adafruit_index.json 

Das ermöglicht es dem Arduino Board Manager die nötigen Adafruit Files zu laden. 

Als nächstes laden wir die Board Files, die wir benötigen. Dazu unter Tools->Board->Board Manager 

anklicken. Der Board Manager öffnet sich, zeigt die installierten Files und sucht im Internet nach 

verfügbaren Files. Das kann einen Moment dauern. 



 

 

 

 

 

Wir benötigen zunächst die Arduino SAM Boards 32 Bit Cortex M0+ Files. Dazu auf dieses Feld rechts irgendwo 

klicken, die Files werden automatisch geladen. Falls bereits installiert steht dort links ein grünes „installed“. 

Falls ein Update verfügbar ist, erscheint rechts ein Button „update“. 

Als nächstes scrollst du nach unten bis zu Adafruit SAMD Boards. Auch diese Files bitte installieren. Bevor wir 

jetzt die nötigen Libraries und das Datenlogger File installieren noch ein paar wichtige Bemerkungen zur 

Arduino Software. 



 

 

 

 

 

 

 

 

 

 

Dokumente \Arduino ist in meinem Fall der sogenannte Sketchbook Ordner. In deinem Sketchbook Ordner 

bitte einen Unterordner \Projekte erstellen. Im Sketchbook Ordner befindet sich auch der Unterordner: 

\libraries in den die eigenen Library- Files kommen. Falls nicht vorhanden, bitte erstellen. 

Hinweis: Wenn in einem Arduino Programm ein Verweis auf ein Library File gegeben ist, sucht Arduino im 

System Library Ordner und in diesem Ordner danach. Ist ein Library File doppelt vorhanden, wird das Systemfile 

vorgezogen. Deshalb werden wir nachher noch einen Ordner verschieben müssen. Doch dazu später. 

Im Stammverzeichnis, also hier arduino-1.8.0 befindet sich ein Ordner libraries. Dort sind die Arduino eigenen 

Systemlibraries abgelegt, unsere hinzugeladenen und eigenen Libraries kommen dort nicht rein! 



 
 

 

 

 

 

 

 

 

 

 

 

 

 

Jetzt noch etwas Feintuning. Den cactus Ordner benennen wir in BME280_I2C um, desgleichen das dort 

befindliche .h File in BME280_I2C.h und das .cpp file in BME280_I2C.cpp. Dies dient lediglich der späteren 

Übersichtlichkeit und hat ansonsten keine Auswirkungen.  

Im Arduino eigenen System Library Ordner (im Arduino Stammverzeichnis) befindet sich ein Ordner SD. Diesen 

bitte aus dem Ordner verschieben (z.B einen library_backup Ordner erstellen und ihn dort hinein schieben), da 

es ansonsten wie oben beschrieben zu Problemen mit den Adafruit SD Files kommt. 

Als nächstes das Datenlogger Programm von unserer Webseite laden und in den Projekte Ordner verschieben 

(Dokumente \Arduino\Projekte). Nun das bestückte Stratoino Board mit einem Micro-USB Kabel mit dem 

Computer verbinden und das Datenlogger .ino File mit Arduino laden und starten.  

Wenn du jetzt das Tools Menu anwählst sollte der Bildschirm so aussehen: 

Als nächstes suchen wir uns die benötigten Libraries im Netz. Von Adafruit benötigen wir die Adafruit 

SD-Master Library: 

(https://github.com/adafruit/SD) und die Adafruit GPS Library: 

(https://github.com/adafruit/Adafruit_GPS).  

Von Arduino benötigen wir die DHTstable Library:   

(https://github.com/RobTillaart/Arduino/tree/master/libraries/DHTstable)  

und von catus.io die BME280 I2C Library: 

(http://static.cactus.io/downloads/library/bme280/cactus_io_BME280_I2C.zip).  

Bitte alles, wie besprochen im eigenen Library Ordner entpacken. 



 

 

 

 

 

Wähle nun den Port an, hinter dem Adafruit Feather M0 steht, also in meinem Fall COM14. Wenn du jetzt auf 

Board Info gehst, sollte eine ähnliche Message wie diese zu sehen sein: BN: Adafruit Feather M0 (Native USB 

Port) VID: 239A PID: 800B SN: Upload any sketch to obtain it). Hier noch einige Infos zum Programm. Hierzu 

einfach mal durchscrollen und die abgebildete Stelle suchen.   

Im nächsten Bild siehst du die verwendeten Libraries des Programms (#include): 



 

 

 

 

 

 

Im folgenden Abschnitt sind die Programmeinstellungen zu sehen z.B das 5 Sekunden Log Intervall 

(log_int_sec). Das Intervall sollte nicht wesentlich kleiner gemacht werden, da das GPS Modul Zeit zur 

Übertragung der Daten benötigt. Die maximale Fileanzahl (max_no_of_files) ist hier mit 100 angegeben, was 

gleichzeitig auch das Maximum ist. 

Im nächsten Abschnitt werden u.a. die Pins und Module konfiguriert, hier beispielsweise oben die Pins für die 

rote und die grüne LED auf dem Datenlogger Modul. 



 

 

 

 

 

 

 

Um das Programm nun auf das Board zu übertragen wähl bitte Sketch->Upload. Das dauert eine ganze Weile 

und nach dieser Zeit sollte das Fenster ungefähr so aussehen: 

Jetzt sollten die LED’s auf den Boards ab und zu blinken. 

Hier ist der Beginn der Programmschleife zu sehen, welche die eigentliche Messung durchführt. Wenn weitere 

Module angeschlossen werden sollen, empfiehlt es sich, die entsprechenden Programmteile direkt hinter 

prepare_Data() anzufügen. 



 

 

 

 

 

 

 

 

 

 

 

 

 

  

Starte nun den seriellen Monitor über das Menü Tools-> Serial Monitor. Vergewissere dich, dass unten 

rechts die richtige Baud Rate eingestellt ist (115200). Im Monitor sind jetzt die Daten des Loggers zu 

sehen. Alle fünf Sekunden wird ein neuer Datensatz geschrieben: 

Du hast es geschafft, alles läuft! 

Hier noch einige programmtechnische Hinweise zum Schluß: 

Beim Start sollte nach einer kurzen Pause das Logger Modul mit der SD Karte 3 x grün blinken. Danach beginnt der 

Aufzeichnungszyklus: 

Blinken rot + grün =    Aufzeichnung erzeugt neues Log und neues File 

Blinken grün =     Aufzeichnung erzeugt neues Log 

Blinken wiederholt 3 x grün Pause 5 sec. =  Aufzeichnung beendet 

Das GPS Modul blinkt im Sekundentakt bis ein Fix gefunden wurde.  Ab da blinkt es alle 15 Sekunden, erst dann 

sind die GPS Daten zuverlässig!  

Falls ein Problem vorliegt blinkt die rote LED des Datenloggers: 

1 x Blinken :     BME Modul nicht erkannt 

2 x Blinken :     Externes Modul nicht erkannt 

3 x Blinken :     Keine SD Karte 

4 x Blinken :     Startfile kann nicht erzeugt werden. 

Bitte die serielle Übertragungsrate (115200) nicht herabsetzen um für die GPS Abfrage genug Zeit zu lassen.  

Logintervall:      > 5 Sekunden (log_int_sec) 

Fileanzah:l     < 100 (max_no_of_files) 

Maximale Zahl der Logs per File:   > 0 (max_no_of_logs) 

Die Files werden auf Micro SD/SDHC geschrieben und liegen im einfachen Textformat vor. Sie sind mit Data_xx 

bezeichnet, xx ist die Filenummer. Alle Files haben das Erstellungsdatum 1.1.2000.  

Die SD Karte muss mit FAT32 formatiert sein. Die Files werden im „Append“ Modus geschrieben. 



 Das Log enthält bei allen Messwerten mindestens 3 Nachkommastellen, auch wenn der Sensor nur eine geringere 

Auflösung besitzt. Dadurch können die Einträge leichter in Excel importiert werden, ohne dass Messwerte von Excel 

ersetzt werden (z.B. durch ein Datum).  

Die Textdateien können separat bearbeitet oder durch Copy/Paste zu einer langen Datei kombiniert werden. Um die 

Datei in Excel sinnvoll zu laden bitte folgende Einstellung verwenden:  

Datei öffnen als txt Datei - Import Einstellung getrennt, MSDOS, Trennzeichen Komma, Leerzeichen und ‚/‘ 

(Schrägstrich) - Standartformat. 

Der nachfolgende Logeintrag dient als Beispiel, in der Textdatei folgen alle Einträge dieses Logs direkt hintereinander 

und werden von CR/LF abgeschlossen. 

LS 00200, Logsekunde 200, das ist bei 5 Sekunden Intervall der 40. Eintrag 

BP 943.850, Bordsensor Pressure  = Luftdruck in hPa 

BH 30.390,         Bordsensor Humidity = Luftfeuchtigkeit innen in % 

BT 24.180,          Bordsensor Temperatur = Innentemperatur in Grad Celsius 

DH 31.400,         D Sensor (ext.) Humidity = Luftfeuchtigkeit außen in %   (--,-) = ungültig 

DT 23.600,         D Sensor (ext.) Temperatur = Außentemperatur in Grad Celsius (--,-) = ungültig 

GT 9:28:3, GPS Zeit  

GD 16/1, GPS Datum 

GF 1/1,  GPS Fix und(/) Fix-Qualität 

GS 3,  Anzahl der momentan gefundenen Satelliten 

GL 1125.277,     GPS Längenrad in Grad (2-3 Stellen) Minuten (2Stellen, 3 Nachkommast.) (00,000 = ungültig) 

GB 4742.185,  GPS Breitengrad in Grad (2-3 Stellen) Minuten (2Stellen, 3 Nachkommast.) (00,000 = ungültig) 

GH 102.6000      GPS Höhe in m (4 nachkommastellen) 

 

Viel Spaß mit dem StratoIno und viele gute und gelungene Ballonmissionen wünscht das SatTec Team! 

 

PS: Achtung – der StartoIno ist ein Datenlogger. Er ersetzt keinesfalls einen GPS-GSM-Tracker, da die 

Daten nicht per Funk gesendet werden! 


